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1. TraiNet 2.0 Installation

1.1. Local Drive or Network Setup

The first decision you will need to make before installing TraiNet is whether to install on your local computer or on another computer on a local area network (LAN).

· Install on a local drive if only one person will be using TraiNet at your site, or if the people who use TraiNet will always use it on the same computer.

· Install on a networked computer (a file server, or a workstation with a shared hard drive) if you want more than one person to have access to TraiNet from different workstations on the LAN.

1.2. Internet Access

Make sure the computer where you install TraiNet – or the workstation from which you will use TraiNet on a network – has Internet access.  Internet access is required to use TraiNet’s data-sharing functionality. See Send and Receive Data Setup below.

1.3. Network Setup

If you decide to install TraiNet on a network, do these things first:

· Decide on which network computer you will install TraiNet. If you are installing on a file server such as Windows NT or Windows 2000 Server, do not perform the installation from the server console. Install from a workstation on the LAN. 

Tip: It’s a good idea to perform the installation at the workstation of the TraiNet administrator or main data entry user.  You gain time by having an important workstation already set up and ready to use when the installation is finished. You can then configure other workstations separately. See Workstation Setup below.

· On the workstation where you will perform the installation, map a drive letter to the network share where you will install TraiNet. Then use that drive letter as the installation location during the install.

1.4. Installation from the CD

Note: On Windows NT, 2000, or XP you may need to have administrator rights to install TraiNet. See the System Files section of the TraiNet Configuration: Directories, Files, Registry, ODBC section below.

1. Insert the TraiNet2 CD in your CD-ROM drive.

2. Click Start (  Run... (  Browse...

3. Navigate to your CD-ROM drive and double-click the Setup.exe file on the TraiNet CD.

4. Most of the time you can simply accept all the default settings in the installation wizard.  If you are installing on a local drive other than c:, or on a mapped network drive (see Network Setup above), do this when you come to the Choose Destination Location dialog:

a. Click Browse...

b. Delete the drive letter c: and type the new drive letter – either another local drive or the network drive you mapped to in Network Setup above.

c. Click OK and continue the installation wizard.

Tip: When changing the drive letter, do not delete the folder name TraiNet2. Just change the drive letter and leave the folder name as it is.

TraiNet Configuration: Directories, Files, Registry, ODBC

Installation Directory
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The installation program will create the following directory structure.

Application File

The installation program copies the main TraiNet2 application file Trainet2.exe to the TraiNet2 folder.  Trainet2.ini is also installed in the Trainet2 folder and holds all of TraiNet’s configuration information.

System Files

TraiNet2 uses ODBC (Open Database Connectivity) for data access, so the TraiNet2 installation program inspects your current ODBC files and installs updates if required. If ODBC updates are needed, you will have to log in with administrator rights to install TraiNet2 on some versions of Windows (NT, 2000, XP).

Data Files/ODBC

The installation program places the TraiNet2 database dbTrainet2.mdb in the TraiNet2 directory and creates an ODBC (Open Database Connectivity) data source that points to the dbTrainet2.mdb file. The ODBC data source is named dbTrainet2 and TraiNet interacts with the database through this ODBC connection. If the TraiNet2 database dbTrainet2.mdb is moved to a different location, the dbTrainet2 ODBC data source must be changed to the new location.

Report Files

The installation program places the TraiNet2 Reporting Database Trainet2Reports.mdb in the report sub-folder. You can move this file to a different location, but you must modify the Trainet2.ini file to inform TraiNet of the new location. See Customizing TraiNet2 Reports Setup below.

Registry Modifications

The installation program makes no modifications of any kind to the Windows registry.

1.5. Workstation Setup

If you install TraiNet on a networked computer, the workstation from which you performed the installation will be set up and ready to use. However, you must perform the following setup tasks at other workstations from which you want to use TraiNet.

Map a drive letter to the network share where TraiNet is installed.

See the help file for your version of Windows, or ask a system administrator how to map a network drive.

Create an ODBC data source that points to the TraiNet database file: dbTrainet2.mdb.

1. In the Windows Control Panel, open ODBC Data Sources. Exactly how you do this varies with recent Windows versions. See Windows help or ask a system administrator.

2. Click the User DSN tab.

3. Click the Add button.

4. Select Microsoft Access driver (*.mdb) from the list.

5. Click Finish.

6. Type dbTrainet2 in the Data Source Name box.

7. Click the Select button

8. Navigate to the TraiNet2 directory – via the mapped drive you created above – and select the dbTrainet2.mdb file.

9. Click OK twice.

Create a shortcut to the Trainet2.exe file on the Desktop

1. Right-click on the Windows Desktop.

2. Select New from the popup menu.

3. Select Shortcut.

4. Click the Browse... button

5. Navigate to the TraiNet2 directory – via the mapped drive you created above – and select the file Trainet2.exe.

6. Click Next.

7. Type the name TraiNet Database. 

8. Click Finished.

1.6. Converting Data from Previous Versions

If you have been using a previous version of TraiNet, your data will have to be converted to TraiNet2 format. Contact trainet@usaid.gov for assistance in upgrading your installation.

2. Initial Data Setup

The TraiNet data model includes a framework into which training programs and trainees are entered. The general framework consists of what TraiNet calls ‘top-tier’ data: strategic objectives (SOs), intermediate results (IRs), and activities.  Since activities are really projects funded by a mission, and since SOs and IRs are clearly mission responsibilities, one realizes that the top-tier data is really mission data. Top-tier data should be entered by the mission, then distributed to all contractors, grantees, or other partners working with that mission.  See Top-tier data in the TraiNet help file for more information.

2.1. Setting Up Top-Tier Data

If you are setting up TraiNet at a mission, your first task should be to enter the mission’s strategic framework – SOs, IRs, and Activities – into TraiNet.  In general, Activities correspond to the contracts or agreements a mission has in place with contractors or grantees. Think of Activities as projects implemented by a contractor or grantee.

If you are setting up TraiNet at a contractor or grantee office, the mission for whom you work should send you its top-tier data. You will import the top-tier data, and it should include an Activity that corresponds to the work you are carrying out for the mission.

In general then, missions are responsible for entering and distributing top-tier data to contractors and grantees. Contractors and grantees are responsible for contacting their mission and requesting top-tier data as soon as they install TraiNet.

See the TraiNet help file for a more detailed discussion of sharing top-tier data using TraiNet’s data sharing features.

2.2. Activities: At Least One

Only in rare cases will TraiNet be installed independent of a particular USAID mission or Washington bureau. In those rare cases, SO and IR data can either be entered or left blank. However, at least one Activity must be entered before Training Programs can be entered into TraiNet. The Training Program wizard requires you to specify an Activity for each program entered into TraiNet.  Therefore, you must enter at least one Activity into TraiNet before starting to enter Training Program data.

Important: in an attempt to speed up data entry, it is not advisable to quickly enter a dummy Activity and skip the step of importing top-tier data (and thus Activity data) from your mission. Any data you enter in this way will have to be corrected manually later, or worse will not fit into the mission’s overall training data reports. So it is almost always best to import top-tier data from the mission before entering training program data.

If you are truly using TraiNet independently of any USAID mission or bureau, you can safely enter one or more Activities and begin entering data.  See the TraiNet help file for directions on entering Activities.

3. Send and Receive Data Setup

3.1. Internet Connectivity

In previous versions of TraiNet, data was transferred using zip files sent on floppy disks or as email attachments. TraiNet2 uses the Internet to transfer data between sites.

The computer where you install TraiNet ‑ or the workstation from which you use TraiNet on a network ‑ must have Internet access in order to perform data sharing.
TraiNet does not automatically dial into a dial-up Internet account as some email or web-browser applications do, nor does it ever access the Internet without the user explicitly performing a data-sharing operation (Send Data or Receive Data). This means that the user must manually establish the Internet connection – using a dial-up connection, for example – or the computer must have a permanent Internet connection for data-sharing to work.  See Data-Sharing in the TraiNet help file for more information.

3.2. TraiNet XML Server

XML stands for eXtensible Markup Language, the industry standard approach to data exchange on the Internet. TraiNet Support maintains an XML server that is available on the Internet 24 hours a day, seven days a week. The TraiNet software uses this XML server to exchange data with other TraiNet sites.

3.3. More Data-Sharing Background

Sharing Training Program Data

An important feature of TraiNet is the power it gives USAID missions and bureaus to collect and aggregate training data from widely scattered sources throughout a mission, a country, or even the world.  Data collection is accomplished using TraiNet’s Send Data and Receive Data functions.

TraiNet can be used by:

· USAID/Washington to collect data from missions world-wide

· Missions to collect data from contractors and grantees in-country

· Contractors and grantees to collect data from different offices or projects

Sharing Top-Tier Data

As mentioned above in Setting Up Top-Tier Data, another important use of TraiNet’s data-sharing functionality is to allow missions to enter top-tier data once and share it with all contractors and grantees.  In fact, for TraiNet to work effectively at the country level, the mission should distribute its top-tier data in exactly that way. Whenever, the top-tier changes (for example, if an SO is updated or a new IR is added) the mission should update its TraiNet top-tier data and resend the top-tier to all contractors and grantees. See the TraiNet2 help file for more information.

3.4. Sending/Receiving Data without Internet Access

If you do not have Internet access and cannot get it at the location where you install TraiNet, contact trainet@usaid.gov for guidance on sending and receiving data without Internet access.

4. Reports Setup

4.1. TraiNet2 Reporting Engine: Access 2000

TraiNet2 uses Microsoft Access as its reporting engine; therefore, MS-Access 2000 or higher must be installed on the user’s computer to produce reports from TraiNet2.

By default, the installation program copies two files into the \Trainet2\Report folder:

	TrainetReports.mdb
	Includes all required TraiNet2 code modules, queries, and reports.

TraiNet data is imported into this database for reporting purposes.

	System9.mdw
	MS-Access workgroup file required to use the reporting database


The TraiNetReports.mdb file can be moved to a different location, but the System9.mdw file must always be located in the \TraiNet2\Report folder.

Locating the TraiNet2 Database

TraiNet2 uses ODBC for its database connection, but the reporting database does not use ODBC and must know the location of the actual TraiNet database file: dbTraiNet2.mdb.  The reporting engine by default looks for dbTrainet2.mdb in the \TraiNet2 folder. If you move the TraiNet2 database to a different location, you must tell the reporting database where it is.  This is described in the next section.

4.2. Customizing TraiNet2 Reports Setup

TraiNet Reports Location

You may wish to customize the TraiNet2 reports configuration. For example

	Problem
	Solution

	Reports run slow over the network.
	Install the reporting database locally on the user’s workstation.

	Users like to customize their own reports and you don’t want them modifying the main reporting database, or their changes conflict with each other


	Give each user a personal copy of the reporting database.


Before customizing the TraiNet Reports setup, it’s helpful to know what TraiNet does when you click Run Report:

1. TraiNet finds the reporting database file: TraiNet2Reports.mdb.

2. TraiNet launches MS-Access.

3. TraiNet tells Access to open TraiNet2Reports.mdb.

4. TraiNet tells Access the location of the TraiNet database dbTraiNet2.mdb
5. Access imports the data from the TraiNet database.
Steps 1 and 4 are crucial to get right: TraiNet must know where the reporting database and the TraiNet database are located. Customizing the reports setup usually amounts to putting the reporting database in a different location, or creating copies of it for individual users.  Either way, TraiNet needs to know where those two files are.

If you move TraiNet2Reports.mdb from its default location in \TraiNet2\Report, tell TraiNet where you moved it by adding the following lines to the \TraiNet2\trainet2.ini file.

[REPORTS]

ReportsFile=x:\MyReportsFolder\Trainet2Reports.mdb

That’s all there is to it. TraiNet will now use the Reporting database in x:\MyReportsFolder instead of the one in \TraiNet2\Report.

TraiNet Data Location

Step 4 above also shows that TraiNet needs to know the location of the dbTraiNet2.mdb database file so the reporting database can import your TraiNet data.  If dbTraiNet2.mdb is in its default location in the \TraiNet2 folder, you need do nothing. TraiNet will find it.  However, if you move dbTraiNet2.mdb to a new location, you must tell TraiNet where the data is or your reports will not work properly.  Do this by adding the following line to the [REPORTS] section of the \TraiNet2\trainet2.ini file.

[REPORTS]

ReportsFile=x:\MyReportsFolder\Trainet2Reports.mdb

DatabaseFile=t:\MyDataFolder\dbTrainet2.mdb

Important!: If you move the dbTrainet2.mdb to a new location, you must also change your ODBC data source to point to the new location. So remember: moving the TraiNet database affects both the operation of TraiNet Reports and the dbTrainet2 ODBC connection.

How to Get Help

If you need help with any custom setup, please contact TraiNet Support at trainet@usaid.gov.

5. Customizing the TraiNet Reporting Database

This section explains how to create new – or modify existing – reports in the TraiNet Reporting Database. This section assumes you are an experienced Access user, and that you have already created queries and reports in other databases. An Access tutorial is beyond the scope of this document.

5.1. How to Open and Modify the TraiNet Reporting Database

Do not attempt to customize the TraiNet Reporting Database by opening it from TraiNet. If you open the Reporting Database by choosing Run Reports in TraiNet, then try to modify the Reporting Database, you changes will not be saved properly.  So first make sure TraiNet2 is closed, then open the Reporting Database in one of these two ways:

TraiNet Reports Shortcut

Choose Start ( Programs ( TraiNet2 ( TraiNet Reports
Note: you will only see this shortcut on the computer where you performed the initial installation of TraiNet2. If you do not find this shortcut, open the Reporting Database from Access as described next.

From Access

1. Launch Microsoft Access

2. Choose Open from the File menu

3. Navigate to the \TraiNet2\Report folder.

4. Open the file named TraiNetReports.mdb
5.2. The TraiNet2 Report Control Panel

TraiNet 2 uses Microsoft Access as its reporting interface.  When a user chooses Run Reports, TraiNet2 launches Microsoft Access, opens the TraiNet2Reports.mdb, and displays this form.
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The ReportControlPanel Form

ReportControlPanel is the main reporting interface for TraiNet2.  ReportControlPanel is opened automatically when the TraiNet2Reports.mdb is opened.  It performs these main functions:

· Displays all available reports, categorized by Training Program, Trainee, and Cost reports.

· Provides an interactive query interface into TraiNet2 data.

· Gives users a way to export data to an Access table, instead of displaying the data in a report.

· Allows users to add reports to the ReportControlPanel interface.

5.3. Adding Reports to the TraiNet2 Report Control Panel

The Report Control Panel comes with many useful TraiNet reports.  Users can also add their own reports to the Control Panel.

The Quick Explanation

1. Open the TraiNet2 Reports Database. See How to Open and Modify the TraiNet Reporting Database above.

2. Create an Access query that your report will use.
Important: The query you create must use one of these special dynamic queries:
DynamicQueryTp or DynamicQueryTrn

3. Create an Access report. To make things easier, use the ReportTemplate as described later.

4. For the report’s Record Source property, choose the query you created in step 2.

5. Open the Report Control Panel form.

6. Click the Tools tab.

7. Click the Manage Reports button.

8. Add the report by filling in the blank row at the bottom of the screen.
Follow the directions in the column headings. 

9. Click the Close button. 
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That’s it!  Your report should now appear in the “What do you want to do?” list on the tab you chose in the left-hand column above.

5.4. How the Report Control Panel Works


Refer to The Quick Explanation above when examining the following diagram.
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5.4.2. Understanding DynamicQueryTp/Trn

The Report Control Panel has a query interface that allows users to filter TraiNet data by many different criteria.  For example, in the screen shown below the user has set a filter for:

· In-country training programs

· Linked to SO-2

The user will expect to see a report containing only training programs that meet the criteria selected. The dynamic queries (DynamicQueryTp or DynamicQueryTrn) are the link between the on-screen filter settings and the data displayed when the selected report is run.  Therefore, each report must be associated with one of the dynamic queries.

5.4.3. Using the Dynamic Queries

When you add a report to the Report Control Panel, the report’s Record Source must be an Access query that uses one of the dynamic queries:

	Query
	What it contains
	When to use it

	DynamicQueryTp
	Basic data about Training Programs, filtered according to the query choices the user makes on the Report Control Panel
	When creating queries/reports that return data about training programs.

	DynamicQueryTrn
	Basic data about Trainees, filtered according to the query choices the user makes on the Report Control Panel
	When creating queries/reports that return data about trainees.


Can I Change the Dynamic Queries?

No. You cannot change the definition of the dynamic queries.  However, there’s no need to.  The dynamic queries contain the foreign keys necessary to link to other TraiNet tables.  It’s better to use one of the dynamic queries as the base of a new query, and simply link to other tables.

	In
	Use

	DynamicQueryTp
	TP_ID to link to other tables containing training program data

	DynamicQueryTrn
	TRN_ID to link to other tables containing trainee data
TPP_ID to link to the training participation (TPP) table
EMP_ID to link to the employee table (EMP)


5.4.4. Creating a Report for the Report Control Panel – The Details

1. Create an Access Query that uses one of the dynamic queries

In this example, DynamicQueryTp and the TraiNet table TPP (Training Program Participation) have been linked in the Access query builder interface.  This query has been saved with the name MyQuery.

The TPP table holds information about who attended a particular training event. It is a common table to use for training program queries, because it tells you who attended a training program.

2. Create a Report that uses your new query as its Record Source

In the screen below, the user has created a new Access Report called MyReport. MyReport uses MyQuery as its Record Source. As we saw above, MyQuery includes a reference to DynamicQueryTp. This provides the crucial link to the Report Control Panel filter interface.

Tip: A quick way to create a new TraiNet2 report is to use the ReportTemplate.

ReportTemplate is an Access query that already has references to

· Report Title

· User query

So those elements will appear in your new report without any effort on your part.

1. Click on the Reports tab in Access.

2. Select ReportTemplate.

3. Type Control-C to copy it to the clipboard.

4. Type Control-V to paste the copy back.

5. Type a new name, e.g., ‘MyReport.’

Just remember to modify the Record Source of the new report. Change it to the query you created in Step 1.

3. Integrate your report into the Report Control Panel

1. Open the Report Control Panel form.

2. Click the Tools tab.
3. Click the Manage Reports button. You will see the screen below.
4. Fill in the blank line at the bottom of the report list, as shown below:

5. Click Close
5.4.5. Check to see if your report is where it should be

Click the Training Program Reports tab in the Report Control Panel.  You will see that your new report is displayed and available for use:
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This choice determines on which tab your report will appear in the�Report Control Panel.





Type anything you wish in these two columns.





Choose the report you created in Step 2.





Choose which dynamic query you used in Step 1.





ReportControlPanel





DynamicQueryTP�or�DynamicQueryTrn
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The query you created in Step 1 uses one of the dynamically created queries:





The report you created in Step 2 uses the query you created in Step 1.








The Report Control Panel displays the query interface and all available reports, including any you have added.





When the user clicks Run Report, �the Report Control Panel:


Generates DynamicQueryTp/Trn using the choices the user made in the query interface.


Runs MyReport, whose Record Source uses DynamicQueryTp/Trn.
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The User Prompt you typed.





The default report title you typed.





Choose MyReport, the name of the report you just created.





Type Training Participation Report as a default title in the printed report. *





Type List Training Participation for the user prompt. *





Choose Program to place your report on the Training Program Reports tab.





Choose DynamicQueryTp because it is used in MyQuery, the Record Source for MyReport.





* These are just examples. You can type anything you like here.





� EMBED PBrush  ���





When you click Run Report DynamicQueryTp will be generated.  Then MyReport will open.
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